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1. Model Rule 1.1 (Comment 8) –
Competence

2. Lawyers are Targets

3. Cloud Computing

Three Important Motivators



[8] To maintain the requisite knowledge and 
skill, a lawyer must keep abreast of changes 

in the law and its practice, including the 
benefits and risks associated with 

relevant technology, engage in 
continuing study and education and comply 

with all continuing legal education 
requirements to which the lawyer is subject.

Model Rules of Professional Conduct

Rule 1.1 – Comment 8:  Maintaining 
Competence















Legal Technology Resource Center





Legal Technology Resource Center



Cloud Computing … What is it, and is it 

Safe?









Main Flavors of Cloud

Software as a Service (“SaaS”)

Infrastructure as a Service 

(“IaaS”)

Definitions
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Datacenters (server farms)

Redundant Internet

Redundant electric

Backup generators

Huge cooling systems

High security

Definitions
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Colocation:

You own the software and the cloud server

Safer than having servers in your office

Can include server maintenance

Definitions
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Absolutely not

You can use combinations of 

software/hardware in-house and 

software/hardware in the cloud

Is This All Or Nothing?
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Lower cost up front

No hardware required

or

Updates included

Tech support included

Anywhere access

Data backup

SaaS Advantages
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Inferior to shrink-wrapped software

No integration with other programs

More expensive over time

Get your data back?

Expensive to divorce

SaaS Drawbacks
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http://www.worldox.com/worldox_partner_solutions?CategoryID=1


No internet = no access 

Updates not always a good thing

Vendor bankruptcy*

They can cut you off*

Bandwidth caps*

*Perceived

SaaS Drawbacks
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Relative Risks of the Cloud
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Bigger security risks:

Office break-in

Laptop, tablet or phone stolen

Disgruntled employee steals

Laptops, tablets & phones unsecured & unencrypted

Email

Reality



Smartphones contain client data which is not 

encrypted.

Laptops contain client data which is not encrypted.

Tablets contain client data which is not encrypted.

Don't encrypt email even if the content and 

attachments are extremely confidential.

No official disaster avoidance or recovery plan.

Aren't sure if backup system actually works (no one 

checks it); and/or we don't back up our data every 

single day.

Reality



Backup media not encrypted.

Server sitting on the floor of file room/wiring closet and 
anyone who walks by would have full access.

People write their logon passwords on sticky notes which 
are attached to their monitors. Further, no policy.

IT people have full access to all client data but had no 
discussion with them about the Rules of Professional 
Conduct, nor do we know anything about the backgrounds 
of their employees.

Reality



Ethical Issues of the 

Cloud

29



Rule 1.1 (“Competence”)

Rule 1.15 (“Safekeeping”)

Rule 1.6 (“Confidentiality”)

Rules in Play



Model Rule 1.6 on

Confidentiality of Information

(a) A lawyer shall not reveal information 
relating to the representation of a client, 
including information protected by the 
attorney-client privilege under applicable 
law, unless the client gives informed 
consent, the disclosure is impliedly 
authorized in order to carry out the 
representation, or the disclosure is 
permitted by division (b) or required by 
division (d) of this rule. 



Model - Comment 17 & 18
Acting Competently to Preserve Confidentiality

[17] Paragraph (c) requires a lawyer to act competently to safeguard 
information relating to the representation of a client against unauthorized 
access by third parties and against inadvertent or unauthorized disclosure 
by the lawyer or other persons who are participating in the representation of 
the client or who are subject to the lawyer’s supervision. The unauthorized 
access to, or the inadvertent or unauthorized disclosure of, information 
relating to the representation of a client does not constitute a violation of 
paragraph (c) if the lawyer has made reasonable efforts to prevent the 
access or disclosure. Factors to be considered in determining the 

reasonableness of the lawyer's efforts include, but are not limited to, the 
sensitivity of the information, the likelihood of disclosure if additional 
safeguards are not employed, the cost of employing additional safeguards, 
the difficulty of implementing the safeguards, and the extent to which the 
safeguards adversely affect the lawyer's ability to represent clients (e.g., by 

making a device or important piece of software excessively difficult to use). 
A client may require the lawyer to implement special security measures not 
required by this Rule or may give informed consent to forgo security 
measures that would otherwise be required by this Rule. 



Model – Comment 17 & 18
Acting Competently to Preserve Confidentiality

[18] When transmitting a communication that includes information 

relating to the representation of a client, the lawyer must take 

reasonable precautions to prevent the information from coming into the 

hands of unintended recipients. This duty, however, does not require that 

the lawyer use special security measures if the method of 

communication affords a reasonable expectation of privacy. Special 

circumstances, however, may warrant special precautions. Factors to be 

considered in determining the reasonableness of the lawyer’s 

expectation of confidentiality include the sensitivity of the information 

and the extent to which the privacy of the communication is protected 

by law or by a confidentiality agreement. A client may require the 

lawyer to implement special security measures not required by this Rule 

or may give informed consent to the use of a means of communication 

that would otherwise be prohibited by this Rule. Whether a lawyer may 

be required to take additional steps in order to comply with other law, 

such as state and federal laws that govern data privacy, is beyond the 

scope of these Rules.



Example - Cloud Computing





An attorney may ethically allow client 

confidential material to be stored in 

“the cloud” provided the attorney takes 

reasonable care to assure that: 

(1) all such materials remain confidential, 

and 

(2) reasonable safeguards are employed to 

ensure that the data is protected from 

breaches, data loss and other risks.

Cloud Computing



Is it Segregated?



Is it Encrypted?

In Transit and at Rest?



Reputable Company in the

Business of Data Storage?



Data Backup / Redundancy



Disclose Confidential Data?



Provider has no Ownership of Data



Dropbox/Cloud Encryption

https://cloud.app.box.com/v/SecurityDataSheet2pg
https://support.google.com/googlecloud/answer/6056693?hl=en
https://support.office.com/en-us/article/data-encryption-in-onedrive-for-business-and-sharepoint-online-6501b5ef-6bf7-43df-b60d-f65781847d6c
https://www.dropbox.com/security#files


Acrobat 11:  Tools >

Protection >

Encrypt >

with Password 

Native Program Encryption



Acrobat DC:  Protect > Encrypt > Encrypt with 

Password

Native Program Encryption



Nuance:  Manage Security > Modify > Security 

Method > Password Security

Native Program Encryption



Word:  File > Info > Protect

Native Program Encryption



PowerPoint:  File > Info > Protect

Native Program Encryption



Need Encryption?



Need Encryption?



Cloud Applications for 

Lawyers
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Procirrus.com

MindShift.com

Rackspace.com

Hosted Servers
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ActionStep

Advologix

Centerbase

Clio

Cosmolex

MyCase

RocketMatter

SmokeBall

Case Management Options
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QuickBooks Online

Bill4Time

Legal Billing

Toggl

FreshBooks

Timesolv Legal

Case management options above

Often need link with QuickBooks online

Time, Billing & Accounting Options
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Chrometa (www.chrometa.com)

Time Tracking
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Smart Time - www.smarttimeapps.com

Time Tracking
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SpeakWrite - www.speakwrite.com
Telephone

Smartphone Apps (iPhone, BlackBerry and Android)

SpeakEasy Dictation Software (for your computer)

Digital Dictation Device

Recorded Tapes (play the tape on the phone or mail)

FAX in your work

FTP Upload and Delivery

Transcription Services
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Example:  28 page document 

= 10,951 words

Therefore, $164.27



LawDocsXpress - www.lawdocsxpress.com

Document preparation

Document review & coding (Summation, CaseMap, 

Concordance)

Email management

Time & billing

E-filing 

IP services

Transcription Services
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LawPay (legal)

LawCharge (legal)

Beacon Processing Solutions (legal)

Virtual Payment Systems (legal)

Square

PayPal

Credit Card Processing
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Google Docs

Microsoft Office 365/Web Apps

Zoho Writer

ThinkFree Office

HyperOffice

Word Processors
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Microsoft Office 365 (also see E3 bundle)

Word Processors
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NetDocuments

Document Management
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LogMeIn: 

www.logmein.com

Gotomypc.com -

www.gotomypc.com

TeamViewer.com

Remote Access
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Mozy Pro

Mozy Home

Carbonite

iBackup

CrashPlan

SOS Online Backup

Backup Services
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AUTOCORRECT
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Training

Management of others

Simple steps

Handling It





Turn Off Auto Complete?

• Tools 
>Options 
>Preferences 
>E-mail 
Options 
>Advanced 
E-mail 
Options.





Security





Surge Suppressors = minimum

Uninterruptible Power Supply (UPS) = much 

better

Check your VA rating

Amps x 120 watts = VA

Easy to overload!

http://tinyurl.com/2ejd6q

Power Protection
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Should use hardware & software

Hardware

Protects against hackers

Share internet connection

Network

Router/Firewall/Switch
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Antivirus

Consider Microsoft Security Essentials (Windows 

Vista or 7)

Windows 8 – baked in

Antivirus & Anti Spyware
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Anti Spyware

Keeps malware from being installed

Never click on a link in an email

Antivirus & Anti Spyware
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Symantec Drive Encryption

SecuriKey Pro

AlertBoot

SecureDoc Full Disk Encryption

Windows BitLocker

Mac FileVault

Hard Drive Encryption
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www.expressvpn.com

Protect Your Connection
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www.expressvpn.com

Protect Your Connection
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Disaster Planning & Backup



Go paperless (or less paper)

Sever Your Servers With Hosted Communications

Centralized Document and Practice Management

Laptops Over Desktops Plus Smartphones and 

iPads

Home Office Essentials (laptop, VoIP phones, 

headset with a microphone, a printer, and a scanner)

Top Five Tips For Preventing Unthinkable Disasters 

From Crippling Your Small Law Firm
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Tape drives 

External hard drives

Network attached storage

Backup Devices
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No Excuses – every day

Should be Unattended

Backup Everything, not just data

Check the Log

Secure Offsite Copy

Run Test Restores

Have a Secondary Method (cloud).

Backup Recommendations
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Carbonite Personal Plus

Unlimited storage

File backup to cloud

Mirror to external drive

Versions

$99/year  

WD My Book 3 TB USB 3.0

$110

Personal Backup Recommendation
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Hosted server – covered

SaaS – covered

On premises server – talk to IT pro

Server Backup Options
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• Data Protection (encryption)

• Remote Wipe

Mobile Devices



• Enable Passcode

• Track Device Feature! 

Mobile Device Safety







iCloud Backup



Find My iPhone/iPad

•

•



Proper Redaction



The National Security Agency released 

guidelines in December 2005, entitled, 

"Redacting with Confidence: How to Safely 

Publish Sanitized Reports Converted From 

Word to PDF."  The document is intended to 

be a guide for government agencies on how 

to sanitize Word documents before they are 

published.  The paper is available at 

http://www.fas.org/sgp/othergov/dod/nsa-

redact.pdf

NSA Document on Word to PDF



PDF Redaction Tool

in Adobe Acrobat Pro

From menu,
choose: View, Toolbars, Redaction



General Rule:  No Duty to Encrypt

Best Practices:  Encrypt Sensitive 
Email

E-Mail Communications



A lawyer may transmit information relating to the 

representation of a client by unencrypted email 

sent over the internet without violating the Model 

Rules of Professional Conduct because the mode 

of transmission affords a reasonable expectation of 

privacy … .  A lawyer should consult with the client 

and follow her instructions as to the mode of 

transmitting highly sensitive information.  Opinion 

99-413, American Bar Association (March 10, 1999). 

E-Mail Communications



Model Rule 1.6 on

Confidentiality of Information

(a) A lawyer shall not reveal information 
relating to the representation of a client, 
including information protected by the 
attorney-client privilege under applicable 
law, unless the client gives informed 
consent, the disclosure is impliedly 
authorized in order to carry out the 
representation, or the disclosure is 
permitted by division (b) or required by 
division (c) of this rule. 



1. Advise clients in engagement letter or fee 
agreement that you use email and warn of 
the risks (get their consent)(Penn requires 
it).

2. If highly sensitive, just do it to be safe.  
Save it as a PDF with a password and send 
as an attachment (without the password in 
the email!)(New Jersey requires it).

E-Mail Communications



Protected Trust Email Encryption



Symantec Desktop Email Encryption



AppRiver

• www.appriver.com 



TrendMicro

• www.trendmicro.com 



Protected Trust –

www.protectedtrust.com

Rpost - www.rpost.com -

registered email service + 

encrypted email

ZixCorp -

www.zixencryption.com

SendItCertified.com

Encrypted Email
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EchoWorx –

http://tinyurl.com/lephmrq

Hushmail – www.hushmail.com

Hightail - https://www.hightail.com/

Encrypted Email
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Use the Blind Copy Field (Bcc)

For Mass Emails!!



Proper Disposal of 

Computer Equipment



You Must Take Reasonable 

Steps to Safeguard Client 

Information and Confidences



Video:  https://www.youtube.com/watch?v=6pIFUOav2xE

Copy Machines

https://www.youtube.com/watch?v=6pIFUOav2xE


You Must Take Reasonable 

Steps to Safeguard Client 

Information and Confidences



Use a Service (PCdisposal.com) 

Do-It-Yourself (Dban, Cybercide, Killdisk, or 

OnTrack DataEraser, etc.)(free-$30)

DOD Sanitizing Standard 5220.22-M

Old Computer Equipment



www.dban.org

FREE

http://www.dban.org/


http://www.escraprecycling.com

1-888-392-7833

Nationwide Pickup



http://www.pcdisposal.com/
http://www.dell.com/recycling


Data on Laptops, Flash Memory, Etc.

Firewall on Laptops (software)

Encrypting Copies of Files

Remote Staff



Same duty to protect confidential and 

privileged client information.

Criminal conduct excluded?

Lost or Stolen Equipment



Mobile Devices with Biometrics

and/or Full Disk Encryption

Lost or Stolen Computer Equipment



BitLocker – Windows 10 (free)

Lost or Stolen Computer Equipment



Symantec Full Disk Encryption

Lost or Stolen Computer Equipment



Encrypted Flash Drives!

$7.00 on Amazon
16 GB

Removable Storage



Ransomware, Viruses, 

Malware, etc.



No Backup

Backup not working (nobody checking)

Tapes need replaced every year

Files saved on local computers

Failure to Backup Client DataFailure to Backup Client Data



Don’t Click on Unknown Links!

Call Before you Click!

Imposters are Tricky

Be Slightly Paranoid

Educate Users!Educate Users!



Backup Portable Devices - Flash

http://lifehacker.com/5640801/usbflashcopy-

automatically-identifies-and-backs-up-your-

flash-drives

http://lifehacker.com/5640801/usbflashcopy-automatically-identifies-and-backs-up-your-flash-drives


Data about data

“Hidden” information

Examples:

Word processing documents

Excel & PowerPoint files

Metadata



Authors

Tracked Changes

Hidden Text

Document Properties

Routing Slip Information

Document Versions

Revision Time

Metadata



Contrary to what some believe,

it is also found in …

WordPerfect files

Adobe Acrobat files

Photographs

Metadata



Microsoft’s internal document management 

before DMS programs were created

Find misplaced documents (MS Search)

Search engines utilize metadata all the time 

(Copernic Desktop, Google Desktop)

Metadata – Why Does it Exist?



If you don’t know about it … yes, it can be

Embarrassment

Ethical Violation 

Malpractice

The Metadata “Nightmare”?



Metadata Stories



Metadata Stories

British government was embarrassed by metadata that 

showed key Downing Street Dossier was plagiarized.





Learn security settings in Word

Learn about

tracked changes

Invest in metadata

removal tool?

Metadata – Action Plan



Microsoft Word 2016 
File > Inspect Document



Adobe Acrobat DC
Protect > Remove Hidden Information



DocsCorp cleanDocs:  www.docscorp.com/cleanDocs
$45 per license/per year



Metadata Assistant:  www.payneconsulting.com
$89 per license



Metadata Removal:  www.workshare.com
$29 per license



Save as RTF is not an option (formatting)

Same issues in WordPerfect – less prevalent 

because not widely used

Exchange PDFs - good option

(but still can contain metadata)

Metadata – Action Plan



PDFs contain metadata

Some PDFs can be edited

Metadata – PDF Options



• Security Settings in Word (Privacy 
Settings)

• Do not display “Markup” when saving as 
a PDF!

Remove Metadata when Creating PDF

from Word



Password to Open

Assign Password to Edit

Restrict Copying of Text and Images

Allow Printing

PDF Security Settings



Always use something!

6-8 not enough.  12 is now the standard.

Combine

Letters — A a J j R r

Numbers— 1 2 3 4 5

Characters — @ # $ % &

Passwords



Hard to remember all?  YES!

Phrase 

mydogremeoisawsome

myd0gr0me0is@ws0me

Passwords



Passwords

https://www.youtube.com/watch?v=opRMrEfAIiI

https://www.youtube.com/watch?v=opRMrEfAIiI


Time to crack an 8 
character password?



Less than 2 hours!



How about a 12 
character password?



17,134 years



How Secure is

Your Password?

http://howsecureismypassword.net/



LastPass (FREE)

•

•

•

•



OnePassword (FREE)

•

•

•

•





Name: Jennifer M. Ramovs, Esq. | Email: jramovs@affinityconsulting.com


